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Introduction
Use this manual to install Workflow for Microsoft Dynamics® GP. Review the 
introductory information about the resources available to you, then use the 
Installation checklist on page 10 as your guide to installing Workflow. You also can 
use this manual to upgrade Workflow. To upgrade Worfklow, use the checklists in 
Chapter 14, “Upgrade checklists.”

Check for current instructions
This information was current as of February 17, 2011. This manual may be updated 
as new information becomes available. Check the Microsoft Dynamics GP 
documentation Web site (http://go.microsoft.com/fwlink/?LinkId=161199) for the 
most current documentation.

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Access Help in Microsoft Dynamics GP
• Access Help on the Workflow Web site
• Send us your documentation comments

What’s in this manual

This manual provides step-by-step instructions for installing Workflow for 
Microsoft Dynamics GP. It includes the following parts:

• Part 1, Getting started, provides an overview of the installation process and 
describes the supported deployment configurations.

• Part 2, Back office server preparation, describes how to configure Microsoft® 
SQL Server® and Microsoft Dynamics GP on your back office server.

• Part 3, Web server preparation, lists the prerequisite software you must install 
on your Web server and explains how to configure Microsoft Office SharePoint® 
Server 2007, Windows® SharePoint Services, SharePoint Server 2010, and 
SharePoint Foundation 2010.

• Part 4, Workflow installation, provides the steps you need to follow when 
running the Workflow installation wizard.

• Part 5, Workflow upgrade, describes the process when upgrading Workflow.

http://go.microsoft.com/fwlink/?LinkId=161199
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Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation, and 
other information.

Access Help in Microsoft Dynamics GP

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web. The following resources are 
available from the Help menu.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites 
tab. Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently 
displayed, type the name of the window, and click Display.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Install Workflow Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as clicking 
items on a menu or a toolbar or clicking buttons in a window. 
This example directs you to go to the File menu and click 
Print.

Bold Bold type indicates the names of fields, tabs, menus, 
commands, and buttons, and text you should type.
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About This Window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. To change the 
way required fields are highlighted, click Microsoft Dynamics GP menu > Tools > 
Setup > User Preferences > Display, and specify a different color and type style.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft software and services.

Access Help on the Workflow Web site

When the Workflow system is installed, a Workflow Web site is created. This Web 
site is built on SharePoint and can be accessed with Microsoft Internet Explorer®. 

When you click the Help icon on a Workflow Web page, the relevant help topic for 
that page is displayed. You can use the search field on the help page to search for 
information. You also can click the Home icon button to browse the contents of the 
Help.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.
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Part 1: Getting started
This part of the documentation provides an overview of the installation process and 
describes the supported deployment configurations. The following chapters are 
included:

• Chapter 1, “Installation overview,” briefly describes the Workflow system and 
provides an installation checklist.

• Chapter 2, “Deployment configurations,” illustrates the supported deployment 
configurations and provides links to system requirements information.

• Chapter 3, “Network requirements,” contains information about the network 
requirements that must be in place before installing Workflow.
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Chapter 1: Installation overview
This chapter briefly describes the Workflow system and provides an installation 
checklist.

The following sections are included:

• What is Workflow?
• How users will interact with the Workflow system
• Installation of Workflow components
• Installation checklist

What is Workflow?

Workflow is a system that you can install for use with Microsoft Dynamics GP. The 
Workflow system provides functionality you can use to create individual workflows, 
or approval processes.

A workflow is the approval process for a document, master record, or batch. A 
workflow defines how a document, master record, or batch “flows” through the 
system by showing who must approve it, and the conditions under which they 
must approve it.

For example, consider the following illustration of a purchase order approval 
workflow. This workflow shows who must approve purchase orders, and the 
conditions under which their approval is required. For example, suppose Sam 
submits a purchase order for $2,000. In this scenario, the purchase order must be 
approved by Frank. If Sam submits a purchase order for $8,000, it must be approved 
by both Frank and Sue.

See the Workflow Administrator’s Guide for more information about setting up and 
using the Workflow system. The Workflow Administrator’s Guide is available on 
the Microsoft Dynamics GP installation media and on the Microsoft Dynamics GP 
documentation Web site (http://go.microsoft.com/fwlink/?LinkId=161199).

Frank

Must approve if 

greater than 

$1,000.

1.

Sam

submits a 

purchase

order.

Sue

Must approve if 

greater than 

$5,000.

2.

Ann

Must approve if 

greater than 

$10,000.

3.

http://go.microsoft.com/fwlink/?LinkId=161199


P A R T  1 G E T T I N G  S T A R T E D

8 W O R K F L O W  I N S T A L L A T I O N  A N D  U P G R A D E   G U I D E

How users will interact with the Workflow system

Users can interact with the Workflow system through Microsoft Dynamics GP, 
SharePoint, and Microsoft Office Outlook®. For current system requirements for 
Microsoft Dynamics GP, see http://go.microsoft.com/fwlink/?LinkId=161197. 

Microsoft Dynamics GP
Workflow functionality is available in many areas of Microsoft Dynamics GP. For 
example, the Purchase Order Entry window enables a user to submit purchase 
orders for approval. This window has a message bar and history pane. The message 
bar displays the document’s status and has buttons for approving and rejecting the 
document. The history pane displays information about previous actions made to 
the document.

History pane

Message bar

http://go.microsoft.com/fwlink/?LinkId=82118
http://go.microsoft.com/fwlink/?LinkId=161197
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SharePoint
When the Workflow system is installed, a Workflow Web site is created. This Web 
site is built on Office SharePoint Server, Windows SharePoint Services, SharePoint 
Server or SharePoint Foundation and can be accessed using Internet Explorer. 
Workflow administrators and managers can use this Web site to set up the 
Workflow system, create individual workflows, and generate reports. Users can use 
this Web site to approve documents and batches that are assigned to them.

Outlook
When a document, master record, or batch is assigned to a user for approval, an 
e-mail message can be sent to the user. The e-mail message displays information 
about the document, master record, or batch and has an Edit this Task link. When 
the user clicks this link, a window appears where the user can approve or reject the 
document, master record, or batch.

Workflow Web site

Click Edit this Task to
approve or reject the

document, master
record, or batch.
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Installation of Workflow components

When you install or upgrade to Microsoft Dynamics GP Release, Workflow 
components are automatically installed on your Microsoft Dynamics GP server and 
client computers. 

You’ll need to install Workflow components on a Web server running Office 
SharePoint Server 2007, Windows SharePoint Services 3.0, SharePoint Server 2010, 
or SharePoint Foundation 2010. This manual provides instructions for installing 
Workflow components on the Web server.

Installation checklist

To install Workflow, complete the following tasks in the order shown.

Task For more information, see...

1. Check for updated instructions.
The information in this manual was current as of 
February 17, 2011. This manual may be updated as 
new information becomes available. Check for an 
updated version of this manual on the Microsoft 
Dynamics GP documentation Web site.

Microsoft Dynamics GP documentation 
Web site (http://go.microsoft.com/fwlink/
?LinkId=161199)

2. Select a deployment configuration.
Select whether to install Workflow in a single-server, 
separate Web server, or multiple Web server 
configuration.

Chapter 2, “Deployment configurations”

3. Be sure your computers meet requirements.
Be sure your computers meet hardware and software 
requirements.

http://go.microsoft.com/fwlink/
?LinkId=187656

4. Be sure your network meets requirements.
Be sure your network meets specified requirements 
and that you’re using the required network protocol.

Chapter 3, “Network requirements”

5. Install and configure SQL Server.
Install and configure SQL Server on your back office 
server.

Chapter 4, “SQL Server configuration”

6. Install and configure Microsoft Dynamics GP.
Install and configure Microsoft Dynamics GP on your 
back office server.

Chapter 5, “Microsoft Dynamics GP 
configuration”

7. Install required software on your Web server.
Install prerequisite software on your Web server, such 
as Web Services for Microsoft Dynamics GP and 
SharePoint.

Chapter 6, “Prerequisite software”

8. Configure SharePoint.
Configure Office SharePoint Server, Windows 
SharePoint Services, SharePoint Server, or SharePoint 
Foundation for use with Workflow.

Chapter 7, “Windows SharePoint 
Services configuration”
Chapter 8, “Office SharePoint Server 
configuration”
Chapter 10, “SharePoint Foundation 
configuration”
Chapter 10, “SharePoint Foundation 
configuration”

9. Prepare for the Workflow installation.
Verify that you have rights to run the Workflow 
installation wizard and verify that the required 
services are running.

Chapter 11, “Before you install”

http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=187656
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10. Install Workflow on your Web server.
Run the Workflow installation wizard on your Web 
server.

Chapter 12, “Installation”

11. Set up the Workflow system.
Set up the Workflow system and create individual 
workflows. For instructions, see the Workflow 
Administrator’s Guide, which is available on the 
Microsoft Dynamics GP installation media and on the 
Microsoft Dynamics GP documentation Web site.

Microsoft Dynamics GP documentation 
Web site (http://go.microsoft.com/fwlink/
?LinkId=161199)

Task For more information, see...

http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=161199
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Chapter 2: Deployment configurations
The Workflow system can be deployed in three different configurations. The 
following sections describe the configurations and provide links to system 
requirements information.

• Single-server configuration
• Separate Web server configuration
• Multiple Web server configuration

Single-server configuration

In a single-server configuration, all the required server-side components (such as 
Microsoft Dynamics GP, Web Services for Microsoft Dynamics GP, SharePoint, and 
Workflow) are installed on one server.

This configuration is recommended for testing and demonstration purposes only. This 
configuration does not provide the best security or performance.

Before you install Workflow in this configuration, be sure the computers meet the 
system requirements listed at http://go.microsoft.com/fwlink/?LinkId=187656.

Back Office Server

· Microsoft SQL Server®

· Microsoft Dynamics GP
· Web Services for Microsoft

Dynamics GP
· SharePoint
· Workflow

Employee Workstation

· Microsoft Dynamics GP
· Outlook
· Internet Explorer

Employee Workstation

· Outlook
· Internet Explorer

http://go.microsoft.com/fwlink/?LinkId=187656
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Separate Web server configuration

The separate Web server configuration consists of two servers. The back office 
server hosts your Microsoft Dynamics GP database and SharePoint database. The 
Web server hosts Web Services for Microsoft Dynamics GP, SharePoint Server, and 
Workflow.

This configuration provides better security and performance than the single-server 
configuration.

Before you install Workflow in this configuration, be sure the computers meet the 
system requirements listed at http://go.microsoft.com/fwlink/?LinkId=187656.

Application Server

· Web Services for Microsoft
Dynamics GP

· SharePoint
· Workflow

Employee Workstation

· Microsoft Dynamics GP
· Outlook
· Internet Explorer

Employee Workstation

· Outlook
· Internet Explorer

Back Office Server

· SQL Server
· Microsoft Dynamics GP
· SharePoint databases

http://go.microsoft.com/fwlink/?LinkId=187656
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Multiple Web server configuration

The multiple Web server configuration consists of one back office server and two or 
more Web servers. The back office server hosts your Microsoft Dynamics GP and 
SharePoint databases. The Web servers host Web Services for Microsoft Dynamics 
GP, SharePoint, and Workflow.

Of the three configurations described in this chapter, the multiple Web server 
configuration provides the best security and performance.

Before you install Workflow in this configuration, be sure the computers meet the 
system requirements listed at http://go.microsoft.com/fwlink/?LinkId=187656.

Application Servrr er

· Web Services for Microsoftff
Dynamics GP

Employee Workstation

· Microsoft Dynamics GP
· Outlook
· Internet Explorer

Employee Workstation

· Outlook
· Internet Explorer

Back Office Server

· SQL Server
· Microsoft Dynamics GP
· Office SharePoint Server

databases Web Server

· Office SharePoint Server
· Workflow

Web Server

· Office SharePoint Server
· Workflow

http://go.microsoft.com/fwlink/?LinkId=187656
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Chapter 3: Network requirements
This chapter contains information about the network requirements that must be in 
place before installing Workflow.

The following sections are included:

• Network environment requirements
• Protocol
• Domain

Network environment requirements

To get the best possible performance from Workflow, be sure that your network 
meets the following requirements.

Protocol

TCP/IP must be running on your network. For more information about TCP/IP, 
refer to your Microsoft Windows® documentation.

IP addresses
Each computer that you use must have a unique IP address (Internet Protocol 
address) associated with it. For more information about IP addresses, refer to your 
networking protocol software documentation.

TCP/IP name resolution
You should use some type of name resolution in your network so that each 
computer is identified by a unique hostname. Name resolution is a method of 
identifying each computer, and can be accomplished by having a specific server act 
as a domain name server, or putting a hosts file on each client and server.

For more information about name resolution using either a domain name server or 
hosts files, refer to your networking protocol software documentation.

Domain

To use Workflow, your Web server, back office server, and employee workstations 
must belong to a domain. In addition, all Workflow users must have valid Windows 
domain accounts.

A domain is a group of computers that are part of a network and share a common 
directory database. A domain is administered as a unit with common rules and 
procedures. Each domain has a unique name. 

For information about setting up and administering a domain, refer to your 
Windows documentation.

Minimum Recommended

Server-to-server 100 Mbps Ethernet 100 Mbps Ethernet

Server-to-client 10 Mbps Ethernet 100 Mbps Ethernet

Remote users (VPN) Broadband: cable or DSL Broadband: cable or DSL
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Part 2: Back office server 
preparation
This part of the documentation helps you configure SQL Server and Microsoft 
Dynamics GP on your back office server. The following chapters are included:

• Chapter 4, “SQL Server configuration,” lists the sort order and authentication 
methods that are supported.

• Chapter 5, “Microsoft Dynamics GP configuration,” describes where you can 
find information about installing or upgrading to Microsoft Dynamics GP 
Release.
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Chapter 4: SQL Server configuration
This chapter describes SQL Server concepts you should understand before 
installing Workflow.

The following sections are included:

• Sort order
• Authentication methods
• Mixed-mode authentication

Sort order

SQL Server will host your SharePoint databases. The SharePoint databases can’t be 
installed on a SQL server that uses a binary sort order.

If your existing SQL server uses a binary sort order, you can create a new instance of 
SQL Server with sort order 52 (Dictionary Order, Case Insensitive) and install the 
SharePoint databases on the new instance. For more information about SQL Server 
instances and sort orders, refer to SQL Server Books Online.

Creating a new instance may require additional SQL Server licensing. Refer to your license 
agreement for more information.

Authentication methods

During the Workflow installation, you’ll need to select the authentication method 
you want to use when connecting to the SQL server that hosts your Microsoft 
Dynamics GP databases. There are two authentication methods:

Windows Trusted Authentication If you select Windows Trusted 
Authentication, be sure that the user who’s logged on to the computer where you’re 
installing Workflow has administrator rights for the Microsoft Dynamics GP SQL 
Server, either as a SQL user or as part of the Local Admin group on the SQL server.

When connecting to SQL Server using the Windows Trusted Authentication 
method, you won’t have to enter a SQL Server-specific logon ID and password. 
Instead, SQL Server identifies you by the Windows user ID you entered when 
logging on to the network. SQL Server then permits or denies logon access based on 
that user ID.

SQL Authentication If you select the SQL Authentication method, you must 
enter a SQL Server-specific logon ID and password during the Workflow 
installation. SQL Server verifies that the logon ID exists, and then permits access.
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Mixed-mode authentication

The SQL Server that hosts your Microsoft Dynamics GP databases must be using 
mixed-mode authentication. Mixed-mode authentication allows you to use either 
Windows Trusted Authentication or SQL Authentication to access the SQL Server. 

Use the following steps to configure SQL Server to use mixed-mode authentication.

To configure SQL Server 2005 to use mixed-mode 
authentication:
1. Open SQL Server Management Studio.

Start > All Programs > Microsoft SQL Server 2005 > SQL Server Management 
Studio

2. Enter connection information to connect to your Microsoft Dynamics GP SQL 
server. Click Connect.

3. Right-click the SQL server with your Microsoft Dynamics GP databases, and 
click Properties. The Server Properties window is displayed.

4. Select the Security page.

5. Select the SQL Server and Windows Authentication mode option.

6. Click OK, then close SQL Server Management Studio.

To configure SQL Server 2008 or SQL Server 2008 R2 to 
use mixed-mode authentication:
1. Open SQL Server Management Studio.

Start > All Programs > Microsoft SQL Server 2008 > SQL Server Management 
Studio
Start > All Programs > Microsoft SQL Server 2008 R2 > SQL Server 
Management Studio

2. Right-click the SQL server with your Microsoft Dynamics GP databases, and 
click Properties.

3. The Server Properties window is displayed. Select the Security page.

4. Select the SQL Server and Windows Authentication mode option.

5. Click OK, then close SQL Server Management Studio.
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Chapter 5: Microsoft Dynamics GP configuration
Before you can install Workflow, you must install or upgrade to Microsoft Dynamics 
GP 2010. Use the following sections to learn more about installing and configuring 
Microsoft Dynamics GP.

• Microsoft Dynamics GP installation and upgrade instructions
• Microsoft Dynamics GP Utilities

Microsoft Dynamics GP installation and upgrade 
instructions

To install or upgrade to Microsoft Dynamics GP 2010, see the Microsoft Dynamics 
GP Installation Instructions or Upgrade Instructions manuals. These manuals are 
available on the Microsoft Dynamics GP documentation Web site (http://
go.microsoft.com/fwlink/?LinkId=161199).

When you install or upgrade to Microsoft Dynamics GP 2010, Workflow 
components are automatically installed on your Microsoft Dynamics GP server and 
client computers. 

Microsoft Dynamics GP Utilities

After installing Microsoft Dynamics GP, use Microsoft Dynamics GP Utilities to 
create your system and company databases. You must create the system database 
and at least one company database before installing Workflow.

For more information about using Microsoft Dynamics GP Utilities, see the 
Microsoft Dynamics GP Installation Instructions manual. This manual is available 
on the Microsoft Dynamics GP documentation Web site (http://go.microsoft.com/
fwlink/?LinkId=161199).

http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=161199
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Part 3: Web server preparation
This part of the documentation helps you prepare your Web server for the 
Workflow installation. The following chapters are included:

• Chapter 6, “Prerequisite software,” lists the software that must be installed on 
your Web server before you can install Workflow.

• Chapter 7, “Windows SharePoint Services configuration,” explains how to 
configure Windows SharePoint Services for use with Workflow.

• Chapter 8, “Office SharePoint Server configuration,” explains how to configure 
Office SharePoint Server for use with Workflow.

• Chapter 9, “SharePoint Server configuration” explains how to configure 
SharePoint Server for use with Workflow.

• Chapter 10, “SharePoint Foundation configuration” explains how to configure 
SharePoint Foundation for use with Workflow.
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Chapter 6: Prerequisite software
Before you can install Workflow, you must install other software on your Web 
server. The following sections describe these software prerequisites:

• Server operating system
• Internet Information Services (IIS) and ASP.NET
• ASP.NET 2.0 Web service extensions
• Secure Sockets Layer (SSL)
• Web Services for Microsoft Dynamics GP
• SharePoint

Server operating system

To install Workflow, your Web server must be running one of the following 
operating systems:

• Microsoft Windows Server® 2003
• Microsoft Windows Server 2003 R2
• Microsoft Windows Server 2008
• Microsoft Windows Server 2008 R2

For more information about supported operating systems, see the system 
requirements listed at http://go.microsoft.com/fwlink/?LinkId=187656.

Internet Information Services (IIS) and ASP.NET

Internet Information Services (IIS) and ASP.NET must be installed on the Web 
server on which you’ll be installing Workflow. To install IIS and ASP.NET, complete 
the following steps for Windows Server 2003 or Windows Server 2008. If you are 
using Windows Server 2008, you can install IIS by adding the Web Server (IIS) 
server role in the Server Manager.

Windows Server 2003
1. In Control Panel, open Add or Remove Programs.

2. Click Add/Remove Windows Components. The Windows Components 
Wizard is displayed.

3. Select Application Server and click Details. The Application Server window is 
displayed.

4. Select the following check boxes:

• ASP.NET
• Enable network COM+ access
• Internet Information Services (IIS)

5. Select Internet Information Services (IIS) and click Details. The Internet 
Information Services (IIS) window is displayed.

6. Select the SMTP Service check box. Click OK to close the Internet Information 
Services (IIS) window.

7. Click OK to close the Application Server window.

http://go.microsoft.com/fwlink/?LinkId=187656
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8. Click Next in the Windows Components Wizard window. When the installation 
process is complete, click Finish.

Windows Server 2008 or Windows Server 2008 R2
1. Open the Server Manager.

Start > Administrative Tools > Server Manager.

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. Click Next to 
continue.

5. Review the information about the Web Server (IIS) role. Click Next to continue.

6. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

7. Click Next.

8. Review the installation messages, and then click Install.

9. After you have viewed the installation results, click Close.

10. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

11. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

12. In the list of available roles, select Application Server. 

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors

Application Development ASP.NET
NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side Includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authentication
Windows Authentication
Digest Authentication
Request Filtering

Performance Static Content Compression

Management Tools IIS Management Console
IIS 6 Management Compatibility
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13. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

14. Click Next to continue.

15. Review the information about the Application Server role. Click Next to 
continue.

16. In the Select Role Services window, select the following components for the 
Management Tools role service.

• COM+ Network Access
• Distributed Transactions
• Incoming Remote Transactions
• Outgoing Remote Transactions

17. Click Next in the Select Role Services window.

18. Review the installation messages, and then click Install.

19. After you have viewed the installation results, click Close.

ASP.NET 2.0 Web service extensions

After you have installed Microsoft .NET Framework 2.0 and IIS, verify that 
ASP.NET 2.0 Web service extensions are allowed. Complete the following steps on 
your Web server.

1. Open Internet Information Services (IIS) Manager.
Start > Administrative Tools > Internet Information Services (IIS) Manager

2. In the left pane of the console, click the plus sign (+) next to the name of your 
Web server.

3. Select the Web Service Extensions folder.

4. In the right pane of the console, verify that ASP.NET 2.0 has the Allowed status. 
If it does not, select ASP.NET 2.0 and click Allow.

Secure Sockets Layer (SSL)

Secure Sockets Layer (SSL) is recommended, but not required, for the Workflow 
Web site. SSL is a protocol that allows Web servers and clients to communicate more 
securely through the use of encryption. When SSL is not used, data sent between the 
client and server is vulnerable to anyone with physical access to the network.

To implement SSL, you must install a certificate and a private key on your Web 
server. For more information about implementing SSL, refer to the IIS Operations 
Guide, available on Microsoft TechNet (http://technet.microsoft.com).

If you implement SSL, you must manually create a Web application for Workflow. For more 
information, see Create a Web application for Workflow (optional) on page 38.

http://technet.microsoft.com
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Web Services for Microsoft Dynamics GP

Web Services for Microsoft Dynamics GP can be installed on a Web server or an 
application server in your network. As discussed in Chapter 2, “Deployment 
configurations,” you can install Web Services for Microsoft Dynamics GP on the 
server you’ll use for Workflow or on another server.

To install Web Services for Microsoft Dynamics GP, follow the instructions in the 
Web Services Installation and Administration Guide. This manual is available on 
the Microsoft Dynamics GP installation media.

SharePoint 

You can install Workflow on Office SharePoint Server, Windows SharePoint 
Services, SharePoint Foundation, or on SharePoint Server. SharePoint must be 
installed on the Web server on which you’ll be installing Workflow. 

SharePoint For information about installing and configuring

Office SharePoint Server Chapter 8, “Office SharePoint Server configuration.”

Windows SharePoint Services Chapter 7, “Windows SharePoint Services configuration.”

SharePoint Server Chapter 9, “SharePoint Server configuration.”

SharePoint Foundation Chapter 10, “SharePoint Foundation configuration.”
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Chapter 7: Windows SharePoint Services 
configuration
This chapter explains how to install and configure Windows SharePoint Services for 
use with Workflow. If you’re installing Workflow with Office SharePoint Server, 
skip this chapter and refer to Chapter 7, “SharePoint Server configuration.”

This chapter doesn’t provide comprehensive information about Windows SharePoint 
Services. For complete information about Windows SharePoint Services concepts and setup 
procedures, see the Windows SharePoint Services documentation.

This chapter contains the following sections:

• User accounts for Windows SharePoint Services
• Install Windows SharePoint Services
• Create a Web application for Workflow (optional)
• Configure a Service Principal Name

User accounts for Windows SharePoint Services

You must create the following domain user accounts for Windows SharePoint 
Services. Windows SharePoint Services uses these accounts to launch services, run 
processes, and connect to the SharePoint databases.

For more information about administrative and service accounts for Windows 
SharePoint Services, refer to the Windows SharePoint Services 3.0 Technical Library 
on Microsoft TechNet (technet.microsoft.com).

These accounts must be dedicated service accounts. These accounts must not be part of any 
workflow process. For example, do not use these accounts when specifying a Workflow 
administrator, manager, originator, or approver.

Install Windows SharePoint Services

Use the following steps to install Windows SharePoint Services on your Web server.

1. Download Windows SharePoint Services 3.0 from the Microsoft Download 
Center (www.microsoft.com/downloads). You should consider installing 
Windows SharePoint Service 3.0 with the latest service pack. 

2. Select the I accept the terms of this agreement option and click Continue.

Domain user 
account

Description Use this account when 
you...

User account 1 This account will be used in several 
ways:
• It will be used to access data from the 

Windows SharePoint Service 
configuration database.

• It will be used to run the Windows 
SharePoint Services Timer service.

• It will act as the identity of the 
SharePoint Central Administration 
application pool.

Run the SharePoint Products and 
Technologies Configuration Wizard 
on page 32

User account 2 This account will act as the identity of the 
Workflow application pool.

Create a Web application for 
Workflow (optional) on page 33.

http://technet.microsoft.com
http://www.microsoft.com/downloads
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3. Click the Advanced installation option. 

4. The Server Type tab is displayed. Select the Web Front End option.

5. Click the Data Location tab. Specify the folders where you want the Windows 
SharePoint Server files installed. You can accept the default locations, or click 
Browse to select different locations.

6. Click the Feedback tab. Indicate whether you want to participate in the 
Customer Experience Improvement Program.

7. Click Install Now to install Windows SharePoint Services.

8. When the installation is complete, the final window of the installation wizard is 
displayed. Select the Run the SharePoint Products and Technologies 
Configuration Wizard now check box. Click Close.

9. Follow the instructions in Run the SharePoint Products and Technologies 
Configuration Wizard to run the SharePoint Products and Technologies 
Configuration Wizard.

Run the SharePoint Products and Technologies 
Configuration Wizard

Use the following steps to run the SharePoint Products and Technologies 
Configuration Wizard.

1. If you just installed Windows SharePoint Services, the SharePoint Products and 
Technologies Configuration Wizard is displayed. If the wizard is not displayed, 
you can start the wizard by clicking Start > Administrative Tools > SharePoint 
Products and Technologies Configuration Wizard.

2. In the Welcome to SharePoint Products and Technologies window, click Next.

3. A dialog box may appear, indicating that services may need to be started or 
reset. Click Yes to continue.

4. The Connect to a Server Farm window is displayed. Click the No, I want to 
create a new server farm option. Click Next.

5. The Specify Configuration Database Settings window is displayed. Enter the 
following information.

Click Next.

Field What to enter

Database server Enter the name of the SQL server that will host the SharePoint 
configuration database.

Database name Enter a name for the SharePoint configuration database, or 
accept the default name.

Username Enter the name of the user account you created for “user 
account 1” in User accounts for Windows SharePoint Services 
on page 31.

Password Enter the password for the user account you created for “user 
account 1” in User accounts for Windows SharePoint Services 
on page 31.
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6. The Configure SharePoint Central Administration Web Application window is 
displayed. If you want the SharePoint Central Administration Web site to use a 
particular port number, select the Specify port number check box and enter the 
port number.

7. Choose either NTLM authentication or Negotiate (Kerberos) authentication. 
Unless you have a specific need for Kerberos authentication, you should choose 
NTLM authentication. For more information about running Windows 
SharePoint Services using Kerberos authentication, refer to Microsoft 
Knowledge Base Article number 832769. (Go to http://support.microsoft.com 
and search for article number 832769.)

If you use Kerberos authentication, your domain administrator must configure 
a Service Principal Name (SPN) for the domain account that is acting as the 
identity of the application pool. For more information, see Configure a Service 
Principal Name on page 34.

Click Next.

8. The Completing the SharePoint Products and Technologies Configuration 
Wizard window is displayed. Review your configuration settings and click 
Next.

9. When the configuration is complete, click Finish to close the wizard. 

Your Web browser will open and display the SharePoint Central Administration 
Web site. You’ll use this site to complete many of the procedures in this chapter.

Create a Web application for Workflow (optional)

A Web application must be created to host the Workflow Web site. You can 
manually create a Web application now, or you can have the Workflow installation 
program create it for you.

If you want to the Workflow Web application to use Kerberos authentication, you 
should manually create the Web application.

1. Open SharePoint Central Administration. 
Start > Administrative Tools > SharePoint Central 3.0 Administration

2. Click the Application Management tab.

3. Under the SharePoint Web Application Management heading, click Create or 
extend Web application.

4. Click Create a new Web application. 

http://support.microsoft.com
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5. Indicate whether you want to use an existing IIS Web site, or create a new IIS 
Web site.

• If you choose to use an existing IIS Web site, select the Web site you want to 
use.

If Business Portal for Microsoft Dynamics GP is installed on this Web server, do 
not select the IIS Web site Business Portal is installed to. Business Portal and 
Workflow can’t use the same Web site.

• If you choose to create a new IIS Web site, enter a description for the Web 
site.

6. In the Security Configuration section, select security options for the Web 
application.

7. In the Application Pool section, click Create a new application pool and enter 
a name (we recommend calling the new application pool Workflow).

When a Web application fails, it usually causes the application pool to fail, as well. If 
you are going to install other Web applications on this server, we recommend that you 
assign them to separate application pools. That way, one failed application can’t cause 
the other applications to fail.

8. Select Configurable and enter the user account you created for SharePoint. (For 
more information about the user account, refer to User accounts for Windows 
SharePoint Services on page 31.) Be sure to enter the account in 
domain\username format.

9. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

We recommend that the database name should be the <Web Application name> - Port#. 
An example of a database name is MySites - 82

Configure a Service Principal Name

If the Workflow Web application was configured to use Kerberos authentication, 
your domain administrator must configure a Service Principal Name (SPN) for the 
domain account that is acting as the identity of the application pool. SPNs are 
unique identifiers for services running on servers. Every service that uses Kerberos 
authentication must have an SPN so that clients can identify the service on the 
network.

Use the Setspn.exe command-line tool to configure an SPN. You can get the tool by 
downloading Support Tools for Windows Server 2003 from the Microsoft Download 
Center (www.microsoft.com/downloads). The Setspn.exe command-line tool is 
available in Windows Server 2008 if you have installed the Active Directory Domain 
Services server role using Server Manager. You must run the Setspn.exe command 
with the appropriate user privilege. Click Start, right-click Command Prompt, and 
then click Run as administrator. 

For information about using the Setspn.exe tool, refer to the Windows Server 2003 
Technical Reference on Microsoft TechNet (technet.microsoft.com).

http://www.microsoft.com/downloads
http://technet.microsoft.com
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Chapter 8: Office SharePoint Server 
configuration
This chapter explains how to install and configure Office SharePoint Server for use 
with Workflow. If you’re installing Workflow with Windows SharePoint Services, 
skip this chapter and refer to Chapter 7, “Windows SharePoint Services 
configuration.”

This chapter only provides information about Office SharePoint Server as it relates to the 
Workflow installation. For complete information about Office SharePoint Server concepts 
and setup procedures, see the Office SharePoint Server documentation.

• Create user accounts for Office SharePoint Server
• Install Office SharePoint Server
• Run the SharePoint Products and Technologies Configuration Wizard
• Install hotfixes
• Start services
• Create a Web application for Workflow (optional)
• Configure a Service Principal Name
• Define a managed path (optional)

Create user accounts for Office SharePoint Server

You must create the following domain user accounts for Office SharePoint Server. 
Office SharePoint Server uses these accounts to launch services, run processes, and 
connect to the SharePoint databases.

For more information about administrative and service accounts for Office 
SharePoint Server, refer to the Office SharePoint Server Technical Library on 
Microsoft TechNet (http://technet.microsoft.com).

These accounts must be dedicated service accounts. These accounts must not be part of any 
workflow process. For example, do not use these accounts when specifying a Workflow 
administrator, manager, originator, or approver.

Domain user 
account

Description Use this account when 
you...

User account 1 This account will be used in several 
ways:
• It will be used to access data from the 

Office SharePoint Server 
configuration database.

• It will be used to run the Windows 
SharePoint Services Timer service.

• It will act as the identity of the 
SharePoint Central Administration 
application pool.

Run the SharePoint Products and 
Technologies Configuration Wizard 
on page 36

User account 2 This account will act as the identity of the 
Workflow application pool.

Create a Web application for 
Workflow (optional) on page 38

http://technet.microsoft.com
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Install Office SharePoint Server

Use the following steps to install Office SharePoint Server on your Web server.

1. Insert the Office SharePoint Server DVD into your Web server computer. The 
Office SharePoint Server installation screen should appear. If the screen does 
not appear automatically, browse the DVD and double-click the Setup.exe file.

2. Mark the I accept the terms of this agreement option and click Continue.

3. Click the Advanced installation option. 

4. The Server Type tab is displayed. Select the Complete option.

5. Click the File Location tab. Specify the folders where you want the Office 
SharePoint Server files installed. You can accept the default locations, or click 
Browse to select different locations.

6. Click the Feedback tab. Indicate whether you want to participate in the 
Customer Experience Improvement Program.

7. Click Install Now to install Office SharePoint Server.

8. When the installation is complete, the final window of the installation wizard is 
displayed. Select the Run the SharePoint Products and Technologies 
Configuration Wizard now check box. Click Close.

9. Follow the instructions in Run the SharePoint Products and Technologies 
Configuration Wizard on page 36 to run the SharePoint Products and 
Technologies Configuration Wizard.

Run the SharePoint Products and Technologies 
Configuration Wizard

Use the following steps to run the SharePoint Products and Technologies 
Configuration Wizard.

1. If you just installed Office SharePoint Server, the SharePoint Products and 
Technologies Configuration Wizard is displayed. If the wizard is not displayed, 
you can start the wizard by clicking Start > Administrative Tools > SharePoint 
Products and Technologies Configuration Wizard.

2. In the Welcome to SharePoint Products and Technologies window, click Next.

3. A dialog box may appear, indicating that services may need to be started or 
reset. Click Yes to continue.

4. The Connect to a Server Farm window is displayed. Click the No, I want to 
create a new server farm option. Click Next.
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5. The Specify Configuration Database Settings window is displayed. Enter the 
following information.

Click Next.

6. The Configure SharePoint Central Administration Web Application window is 
displayed. If you want the SharePoint Central Administration Web site to use a 
particular port number, select the Specify port number check box and enter the 
port number.

7. Choose either NTLM authentication or Negotiate (Kerberos) authentication. 
Unless you have a specific need for Kerberos authentication, you should choose 
NTLM authentication. For more information about running Office SharePoint 
Server using Kerberos authentication, refer to Microsoft Knowledge Base 
Article number 832769. (Go to http://support.microsoft.com and search for 
article number 832769.)

If you use Kerberos authentication, your domain administrator must configure 
a Service Principal Name (SPN) for the domain account that is acting as the 
identity of the application pool. For more information, see Configure a Service 
Principal Name on page 39.

Click Next.

8. The Completing the SharePoint Products and Technologies Configuration 
Wizard window is displayed. Review your configuration settings and click 
Next.

9. When the configuration is complete, click Finish to close the wizard. 

Your Web browser will open and display the SharePoint Central Administration 
Web site. You’ll use this site to complete many of the procedures in this chapter.

Field What to enter

Database server Enter the name of the SQL server that will host the SharePoint 
configuration database.

Database name Enter a name for the SharePoint configuration database, or 
accept the default name.

Username Enter the name of the user account you created for “user 
account 1” in Create user accounts for Office SharePoint Server 
on page 35.

Password Enter the password for the user account you created for “user 
account 1” in Create user accounts for Office SharePoint Server 
on page 35.

http://support.microsoft.com
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Install hotfixes

Before installing Workflow, install the following hotfixes on the Web server running 
Office SharePoint Server.

Windows Workflow Foundation hotfix This hotfix resolves issues regarding 
the escalation of tasks. To download and install this hotfix, go to the Microsoft 
Download Center (http://www.microsoft.com/downloads) and search for 
KB932394.

Office SharePoint Server hotfix This hotfix resolves issues that occur when 
you submit multiple documents for approval from a list, or when you deactivate a 
workflow. For more information about this hotfix, go to the Microsoft Help and 
Support Web site (http://support.microsoft.com) and search for Knowledge Base 
article 934790. To obtain this hotfix, contact Microsoft Customer Support Services. 
For a complete list of Microsoft Customer Support Services telephone numbers and 
information about support costs, go to http://support.microsoft.com/contactus/
?ws=support.

Start services

After you have installed Office SharePoint Server and run the SharePoint Products 
and Technologies Configuration wizard, you must start Office SharePoint Server 
services. The services you need to start depend on your server topology and the 
server role you select.

1. Open SharePoint Central Administration.
Start > Administrative Tools > SharePoint 3.0 Central Administration

2. Click the Operations tab.

3. Under the Topology and Services heading, click Services on server. The 
Services on Server: <Server Name> page is displayed.

4. Select a server role. For information about these roles, see the Office SharePoint 
Server documentation.

5. In the Services table, verify that the Windows SharePoint Services Web 
Application service has a status of Started. It it does not, click the Start link.

Other services may be required, depending on the server role you selected. For 
more information about these services, see the Office SharePoint Server 
documentation.

Create a Web application for Workflow (optional)

A Web application must be created to host the Workflow Web site. You can 
manually create the Web application now, or you can have the Workflow 
installation program create it for you.

If you want the Workflow Web application to use Kerberos authentication, you 
should manually create the Web application.

If you have implemented SSL, you must manually create a Web application for Workflow.

http://www.microsoft.com/downloads
http://support.microsoft.com
http://support.microsoft.com/contactus/?ws=support
http://support.microsoft.com/contactus/?ws=support
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1. Open SharePoint Central Administration. 
Start > Administrative Tools > SharePoint 3.0 Central Administration

2. Click the Application Management tab.

3. Under the SharePoint Web Application Management heading, click Create or 
extend Web application. The Create or Extend Web Application page is 
displayed.

4. Click Create a new Web application. The Create New Web Application page is 
displayed.

5. Indicate whether you want to use an existing IIS Web site, or create a new IIS 
Web site.

• If you choose to use an existing IIS Web site, select the Web site you want to 
use.

If Business Portal for Microsoft Dynamics GP is installed on this Web server, do 
not select the IIS Web site Business Portal is installed to. Business Portal and 
Workflow can’t use the same Web site.

• If you choose to create a new IIS Web site, enter a description for the Web 
site.

6. In the Security Configuration section, select security options for the Web 
application.

7. In the Application Pool section, select the Create a new application pool 
option and enter a name for the application pool. For example, you may want to 
name the application pool Workflow.

When a Web application fails, it usually causes the application pool to fail, as well. If 
you are going to install other Web applications on this server, we recommend that you 
assign them to separate application pools. That way, one failed Web application can’t 
cause the other Web applications to fail.

8. Select the Configurable option and enter a domain user account name and 
password. The user account will act as the identity of this Web application’s 
application pool. (You should enter the account you created for “user account 
4” in Create user accounts for Office SharePoint Server.) Be sure to enter the account 
information in domain\username format.

9. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

Configure a Service Principal Name

If the Workflow Web application was configured to use Kerberos authentication, 
your domain administrator must configure a Service Principal Name (SPN) for the 
domain account that is acting as the identity of the application pool. SPNs are 
unique identifiers for services running on servers. Every service that uses Kerberos 
authentication must have an SPN so that clients can identify the service on the 
network.
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Use the Setspn.exe command-line tool to configure an SPN. You can get the tool by 
downloading Support Tools for Windows Server 2003 from the Microsoft Download 
Center (http://www.microsoft.com/downloads).

For information about using the Setspn.exe tool, refer to the Windows Server 2003 
Technical Reference on Microsoft TechNet (http://technet.microsoft.com).

Define a managed path (optional)

If you chose not to 
create a Web 
application for 
Workflow (as described 
in Create a Web 
application for 
Workflow (optional) on 
page 38), skip this 
section.

When running the Workflow installation wizard, you’ll be asked to select a 
managed path. Managed paths specify which paths in the URL namespace of a Web 
application are managed by Windows SharePoint Services.

By default, the /sites managed path is selected in the Workflow installation wizard. 
This means that the default URL of the Workflow Web site is:

http://ServerName/sites/DynamicsGPWorkflow

If you want the Workflow Web site to use a different managed path, use the 
following steps to define the managed path. You’ll then be able to select the 
managed path when running the Workflow installation wizard.

1. Open SharePoint Central Administration. 
Start > Administrative Tools > SharePoint 3.0 Central Administration

2. Click the Application Management tab.

3. Under the SharePoint Web Application Management heading, click Define 
managed paths. The Define Managed Paths page is displayed.

4. If the name of the Workflow Web application does not appear in the Web 
Application field, click the down arrow to change the Web application.

5. In the Path field, enter a name for the new managed path.

6. From the Type list, select one of the following:

Wildcard Inclusion Select this option if you want Windows SharePoint 
Services to manage all sites within this managed path.

Explicit Inclusion Select this option if you want Windows SharePoint 
Services to manage only the site that is specified in the path. Sites subordinate 
to the specified path will not be managed by Windows SharePoint Services.

7. Click OK.

http://www.microsoft.com/downloads
http://technet.microsoft.com
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Chapter 9: SharePoint Server configuration
This chapter explains how to install and configure SharePoint Server 2010, 
Enterprise Edition for use with Workflow. If you’re installing Business Portal with 
SharePoint Foundation only, skip this chapter and refer to Chapter 6, “SharePoint 
Foundation configuration.”

This chapter doesn’t provide comprehensive information about SharePoint Server. For 
complete information about SharePoint Server concepts and setup procedures, see the 
SharePoint Server documentation.

This information is divided into the following sections:

• Create user accounts for SharePoint Server
• Install SharePoint Server
• Run the SharePoint Products Configuration Wizard
• Start services in SharePoint Server
• Create a web application for Workflow using SharePoint Server (optional)
• Configure a Service Principal Name

Create user accounts for SharePoint Server

You must first create domain user accounts that SharePoint can use to launch 
services, run processes, and connect to the SQL server. 

You don’t need to create these accounts if you’re going to use the basic installation method 
for SharePoint Server.

You will need to create the following user accounts for SharePoint Server. For more 
information about administrative and service accounts for SharePoint Server, refer 
to the SharePoint Server Technical Library on Microsoft TechNet 
(technet.microsoft.com).

These accounts must be dedicated service accounts. These accounts must not be part of any 
workflow process. For example, do not use these accounts when specifying a Workflow 
administrator, manager, originator, or approver.

Install SharePoint Server

Refer to the documentation included on your SharePoint Server DVD for 
information about installing.

Use the following steps to install SharePoint Server on your Web server.

Domain user 
account

Description For more information

User account 1 This account will be used in several ways:
• It will be used to access data from the SharePoint Server 

configuration database.
• It will be used to run the SharePoint 2010 Timer service.
• It will act as the identity of the SharePoint Central Administration 

application pool.

Run the SharePoint Products 
Configuration Wizard on page 42

User account 2 This account will act as the identity of the Workflow application pool. Create a web application for Workflow 
using SharePoint Server (optional) on 
page 44

http://technet.microsoft.com
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1. Insert the SharePoint Server DVD into your Web server computer. The 
SharePoint Server installation screen should appear. If the screen does not 
appear automatically, browse the DVD and double-click the Setup.exe file.

2. Click Install software prerequisites on the SharePoint Foundation 2010 Start 
page.

3. Click Next in the Microsoft SharePoint Products 2010 Preparation Tool. This 
tool installs and configures all the required prerequisites for SharePoint 
Foundation 2010.

4. Select the I accept the terms of the License Agreement(s) option and click Next.

Depending on the prerequisites that are being installed, you may need to restart 
your computer.

5. Click Finish after the prerequisites have been installed.

You may need to restart your computer.

6. Click Install SharePoint Server on the SharePoint Server 2010 Start page.

7. Enter the product key and click Continue.

8. Select the I accept the terms of this agreement option and click Continue.

9. Click Server Farm.

10. The Server Type tab is displayed. Select the Complete option.

11. Click the Data Location tab. Specify the folders where you want the SharePoint 
Foundation files installed. You can accept the default locations, or click Browse 
to select different locations.

12. Click Install Now to install SharePoint Server.

13. When the installation is complete, the final window of the installation wizard is 
displayed. Select the Run the SharePoint Products Configuration Wizard now 
check box. Click Close.

14. Follow the instructions in Run the SharePoint Products Configuration Wizard on 
page 42 to run the SharePoint Products Configuration Wizard.

Run the SharePoint Products Configuration Wizard

Use the following steps to run the SharePoint Products Configuration Wizard. The 
SharePoint Products Configuration Wizard automates several configuration tasks, 
including installing and configuring the configuration database, installing 
SharePoint services, and creating the Central Administration web site.

1. If you just installed SharePoint Server, the SharePoint Products Configuration 
wizard is displayed. If the wizard is not displayed, you can start the wizard by 
clicking Start > All Programs > Microsoft SharePoint 2010 Products > 
SharePoint 2010 Products Configuration wizard.

2. In the Welcome to SharePoint Products window, click Next.
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3. A dialog box may appear, indicating that services may need to be started or 
reset. Click Yes to continue.

4. The Connect to a Server Farm window is displayed. Select the Create a new 
server farm option. Click Next.

5. The Specify Configuration Database Settings window is displayed. Enter the 
following information.

Click Next.

6. In the Specify Farm Security Settings window is displayed. Enter a passphrase. 
Click Next.

7. The Configure SharePoint Central Administration Web Application window is 
displayed. If you want the SharePoint Central Administration Web site to use a 
particular port number, select the Specify port number check box and enter the 
port number.

8. Choose either NTLM authentication or Negotiate (Kerberos) authentication. 
Unless you have a specific need for Kerberos authentication, you should choose 
NTLM authentication. For more information about running SharePoint Server 
using Kerberos authentication, refer to Microsoft Knowledge Base Article 
number 832769. (Go to http://support.microsoft.com and search for article 
number 832769.)

If you use Kerberos authentication, your domain administrator must configure 
a Service Principal Name (SPN) for the domain account that is acting as the 
identity of the application pool. For more information, see Configure a Service 
Principal Name on page 45.

Click Next.

9. The Completing the SharePoint Products Configuration Wizard window is 
displayed. Review your configuration settings and click Next.

10. When the configuration is complete, click Finish to close the wizard. 

Your Web browser will open and display the SharePoint Central Administration 
Web site. You’ll use this site to complete many of the procedures in this chapter.

Field What to enter

Database server Enter the name of the SQL server that will host the SharePoint 
configuration database.

Database name Enter a name for the SharePoint configuration database, or 
accept the default name.

Username Enter the name of the user account you created for “user 
account 1” in Create user accounts for SharePoint Server on 
page 41.

Password Enter the password for the user account you created for “user 
account 1” in Create user accounts for SharePoint Server on 
page 41.

http://support.microsoft.com
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Start services in SharePoint Server

After you have installed and configured SharePoint Server on all of your front-end 
servers, you must configure SharePoint Server services. The services you need to 
configure depend on your server topology and the server roles you deploy. For 
Business Portal, you must start the Microsoft SharePoint Foundation Web 
Application at a minimum.

Use the following procedure to start services. For more information about services, 
see the SharePoint Server documentation.

1. Open SharePoint Central Administration.
Start > SharePoint 2010 Products > SharePoint Central Administration

2. Under System Settings, click Manage services on server.

3. Start the required services for your configuration. For more information about 
these services, see the SharePoint Server documentation.

You should verify that the Microsoft SharePoint Foundation Web Application 
service has a status of Started. It it does not, click the Start link.

Create a web application for Workflow using 
SharePoint Server (optional)

A web application must be created to host the Workflow web site. You can manually 
create a Web application now, or you can have the Workflow installation program 
create it for you.

If you want to the Workflow Web application to use Kerberos authentication, you 
should manually create the Web application.

For more information about web applications, refer to the SharePoint Products 
Technical Library on Microsoft TechNet (technet.microsoft.com).

To create a web application:

1. Open SharePoint Central Administration. 
Start > All programs > Microsoft SharePoint 2010 Products > SharePoint 2010 
Central Administration

2. Click Application Management.

3. Under the Web Applications heading, click Manage web applications.

4. Click New in the ribbon to open the Create New Web Application page. 

5. Indicate whether you want to use an existing IIS Web site, or create a new IIS 
Web site.

• If you choose to use an existing IIS Web site, select the Web site you want to 
use.

http://technet.microsoft.com
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If Business Portal for Microsoft Dynamics GP is installed on this Web server, do 
not select the IIS Web site Business Portal is installed to. Business Portal and 
Workflow can’t use the same Web site.

• If you choose to create a new IIS Web site, enter a description for the Web 
site.

6. In the Security Configuration section, select security options for the Web 
application.

7. In the Application Pool section, click Create a new application pool and enter 
a name (we recommend calling the new application pool Workflow).

When a web application fails, it usually causes the application pool to fail, as well. If you 
are going to install other web applications on this server, we recommend that you assign 
them to separate application pools. That way, one failed application can’t cause the other 
applications to fail.

8. Select Configurable and enter the user account you created for SharePoint. (For 
more information about the user account, refer to Create user accounts for 
SharePoint Server on page 41.) Be sure to enter the account in domain\username 
format.

9. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

We recommend that the database name should be the <Web Application name> - Port#. 
An example of a database name is MySites - 82

10. On the Application Created page, click OK. 

Configure a Service Principal Name

If the Workflow web application was configured to use Kerberos authentication and 
the application pool identity is a domain account, your domain administrator must 
configure a Service Principal Name (SPN) for that account. Service principal names 
are unique identifiers for services running on servers. Every service that uses 
Kerberos authentication must have an SPN so that clients can identify the service on 
the network.

If the application pool identity for the SharePoint site is configured to use a built-in account 
such as Network Service, you do not have to set up an SPN. The built-in accounts are 
automatically configured to work with Kerberos authentication.

Use the Setspn.exe command-line tool to configure an SPN. The Setspn.exe 
command-line tool is available in Windows Server 2008 R2 if you have installed the 
Active Directory Domain Services server role using Server Manager. You must run 
the Setspn.exe command with the appropriate user privilege. Click Start, right-click 
Command Prompt, and then click Run as administrator. 
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Chapter 10: SharePoint Foundation configuration
This chapter explains how to install and configure SharePoint Foundation 2010 for 
use with Workflow. If you’re installing Workflow with SharePoint Server 2010, skip 
this chapter and refer to Chapter 9, “SharePoint Server configuration.”

This chapter doesn’t provide comprehensive information about SharePoint Foundation 2010. 
For complete information about SharePoint Foundation 2010 concepts and setup 
procedures, see the SharePoint Foundation 2010 documentation.

This chapter contains the following sections:

• Create user accounts for SharePoint Foundation
• Install SharePoint Foundation
• Create a web application for Workflow using SharePoint Foundation (optional)
• Configure a Service Principal Name

Create user accounts for SharePoint Foundation

You must first create user accounts that SharePoint can use to launch services, run 
processes, and connect to the SQL server.

You don’t need to create these accounts if you’re going to use the stand alone installation 
method for SharePoint Foundation.

You’ll need to create the following user accounts for SharePoint Foundation. For 
more information about administrative and service accounts for SharePoint 
Foundation, refer to the SharePoint Products Technical Library on Microsoft 
TechNet (technet.microsoft.com).

These accounts must be dedicated service accounts. These accounts must not be part of any 
workflow process. For example, do not use these accounts when specifying a Workflow 
administrator, manager, originator, or approver.

Domain user 
account

Description Use this account when 
you...

User account 1 This account will be used in several 
ways:
• It will be used to access data from the 

SharePoint Foundation configuration 
database.

• It will be used to run the SharePoint 
2010 Timer service.

• It will act as the identity of the 
SharePoint Central Administration 
application pool.

Run the SharePoint Products 
Configuration wizard on page 48

User account 2 This account will act as the identity of the 
Workflow application pool.

Create a web application for 
Workflow using SharePoint 
Foundation (optional) on page 50.

http://technet.microsoft.com
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Install SharePoint Foundation

Use the following steps to install SharePoint Foundation on your web server. 

1. Download SharePoint Foundation 2010 from the Microsoft Download Center 
(www.microsoft.com/downloads). Refer to the SharePoint Products Technical 
Library on Microsoft TechNet (technet.microsoft.com) for information about 
installing.

2. Click Install software prerequisites on the SharePoint Foundation 2010 Start 
page.

3. Click Next in the Microsoft SharePoint Products Preparation Tool. This tool 
installs and configures all the required prerequisites for SharePoint Foundation 
2010.

4. Select the I accept the terms of this agreement option and click Continue.

Depending on the prerequisites that are being installed, you may need to restart 
your computer.

5. Click Finish after the prerequisites have been installed.

You may need to restart your computer.

6. Click Install SharePoint Foundation on the SharePoint Foundation 2010 Start 
page.

7. Select the I accept the terms of this agreement option and click Continue.

8. Click Server Farm.

9. The Server Type tab is displayed. Select the Complete option.

10. Click the Data Location tab. Specify the folders where you want the SharePoint 
Foundation files installed. You can accept the default locations, or click Browse 
to select different locations.

11. Click Install Now to install SharePoint Foundation.

12. When the installation is complete, the final window of the installation wizard is 
displayed. Select the Run the SharePoint Products Configuration Wizard now 
check box. Click Close.

13. Follow the instructions in Run the SharePoint Products Configuration wizard on 
page 48 to run the SharePoint Products Configuration Wizard.

Run the SharePoint Products Configuration wizard

Use the following steps to run the SharePoint Products Configuration wizard.The 
SharePoint Products Configuration Wizard automates several configuration tasks, 
including installing and configuring the configuration database, installing 
SharePoint Foundation services, and creating the Central Administration web site.

http://www.microsoft.com/downloads
http://technet.microsoft.com
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1. If you just installed SharePoint Foundation, the SharePoint Products 
Configuration wizard is displayed. If the wizard is not displayed, you can start 
the wizard by clicking Start > All Programs > Microsoft SharePoint 2010 
Products > SharePoint 2010 Products Configuration wizard.

2. In the Welcome to SharePoint Products window, click Next.

3. A dialog box may appear, indicating that services may need to be started or 
reset. Click Yes to continue.

4. The Connect to a Server Farm window is displayed. Select the Create a new 
server farm option. Click Next.

5. The Specify Configuration Database Settings window is displayed. Enter the 
following information.

Click Next.

6. In the Specify Farm Security Settings window is displayed. Enter a passphrase. 
Click Next.

7. The Configure SharePoint Central Administration Web Application window is 
displayed. If you want the SharePoint Central Administration Web site to use a 
particular port number, select the Specify port number check box and enter the 
port number.

8. Choose either NTLM authentication or Negotiate (Kerberos) authentication. 
Unless you have a specific need for Kerberos authentication, you should choose 
NTLM authentication. For more information about running SharePoint 
Foundation using Kerberos authentication, refer to Microsoft Knowledge Base 
Article number 832769. (Go to http://support.microsoft.com and search for 
article number 832769.)

If you use Kerberos authentication, your domain administrator must configure 
a Service Principal Name (SPN) for the domain account that is acting as the 
identity of the application pool. For more information, see Configure a Service 
Principal Name on page 51.

Click Next.

9. The Completing the SharePoint Products Configuration Wizard window is 
displayed. Review your configuration settings and click Next.

10. When the configuration is complete, click Finish to close the wizard. 

Field What to enter

Database server Enter the name of the SQL server that will host the SharePoint 
configuration database.

Database name Enter a name for the SharePoint configuration database, or 
accept the default name.

Username Enter the name of the user account you created for “user 
account 1” in Create user accounts for SharePoint Foundation 
on page 47.

Password Enter the password for the user account you created for “user 
account 1” in Create user accounts for SharePoint Foundation 
on page 47.

http://support.microsoft.com
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Your Web browser will open and display the SharePoint Central Administration 
Web site. You’ll use this site to complete many of the procedures in this chapter.

Create a web application for Workflow using 
SharePoint Foundation (optional) 

A Web application must be created to host the Workflow Web site. You can 
manually create a Web application now, or you can have the Workflow installation 
program create it for you.

If you want to the Workflow Web application to use Kerberos authentication, you 
should manually create the Web application.

For more information about web applications, refer to the SharePoint Products 
Technical Library on Microsoft TechNet (technet.microsoft.com).

1. Open SharePoint Central Administration. 
Start > All programs > Microsoft SharePoint 2010 Products > SharePoint 2010 
Central Administration

2. Click Application Management.

3. Under the Web Applications heading, click Manage web applications.

4. Click New in the ribbon to open the Create New Web Application page. 

5. Indicate whether you want to use an existing IIS Web site, or create a new IIS 
Web site.

• If you choose to use an existing IIS Web site, select the Web site you want to 
use.

If Business Portal for Microsoft Dynamics GP is installed on this Web server, do 
not select the IIS Web site Business Portal is installed to. Business Portal and 
Workflow can’t use the same Web site.

• If you choose to create a new IIS Web site, enter a description for the Web 
site.

6. In the Security Configuration section, select security options for the Web 
application.

7. In the Application Pool section, click Create a new application pool and enter 
a name (we recommend calling the new application pool Workflow).

When a web application fails, it usually causes the application pool to fail, as well. If you 
are going to install other web applications on this server, we recommend that you assign 
them to separate application pools. That way, one failed application can’t cause the other 
applications to fail.

8. Select Configurable and enter the user account you created for SharePoint. (For 
more information about the user account, refer to Create user accounts for 
SharePoint Foundation on page 47.) Be sure to enter the account in 
domain\username format.

http://technet.microsoft.com
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9. Verify that the database name and other information on the page is correct and 
click OK. When the process is complete, the Application Created page is 
displayed. 

We recommend that the database name should be the <Web Application name> - Port#. 
An example of a database name is MySites - 82

10. On the Application Created page, click OK. 

Configure a Service Principal Name

If the Business Portal web application was configured to use Kerberos 
authentication and the application pool identity is a domain account, your domain 
administrator must configure a Service Principal Name (SPN) for that account. 
Service principal names are unique identifiers for services running on servers. 
Every service that uses Kerberos authentication must have an SPN so that clients 
can identify the service on the network.

If the application pool identity for the SharePoint site is configured to use a built-in account 
such as Network Service, you do not have to set up an SPN. The built-in accounts are 
automatically configured to work with Kerberos authentication.

Use the Setspn.exe command-line tool to configure an SPN. The Setspn.exe 
command-line tool is available in Windows Server 2008 R2 if you have installed the 
Active Directory® Domain Services server role using Server Manager. You must run 
the Setspn.exe command with the appropriate user privilege. Click Start, right-click 
Command Prompt, and then click Run as administrator. 

For information about using the Setspn.exe tool, refer to the Windows Server 2008 
Technical Reference on Microsoft TechNet (technet.microsoft.com).

http://technet.microsoft.com
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Part 4: Workflow installation
This part of the documentation explains how to run the Workflow installation 
wizard. The following chapters are included:

• Chapter 11, “Before you install,” explains the user rights you must have to run 
the Workflow installation wizard. Information on how to start the required 
services is also included.

• Chapter 12, “Installation,” provides step-by-step instructions for running the 
Workflow installation wizard.

• Chapter 13, “Maintenance,” explains how to repair Workflow files and remove 
Workflow from your Web server.
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Chapter 11: Before you install
Before you start the Workflow installation wizard, complete the following tasks:

• Verify that you have access rights to install
• Start services

Verify that you have access rights to install

To run the Workflow installation wizard, you must be logged on to the Web server 
computer as a domain user with the following access rights.

Administrator rights on the server Your domain user account must be a 
member of the Administrators group on the Web server where Workflow will be 
installed.

Administrator rights for SQL Server During the installation, you will be 
prompted to enter SQL Server connection information.

• If you want to connect to SQL Server using Windows Trusted Authentication, 
you must log on to the Web server with a Windows logon ID that has 
administrative rights to SQL Server.

• If you want to connect to SQL Server using SQL Authentication, you’ll need to 
enter a SQL Server administrator logon ID and password during the 
installation.

Administrator of the Dynamics Security Admin Service You must be an 
administrator of the Dynamics Security Admin Service.

Start services

To run the Workflow installation wizard, the following services must be running for 
SharePoint Foundation and SharePoint Server:

• SharePoint 2010 Administration
• SharePoint 2010 Timer

The following services must be running for Windows SharePoint Services and 
Office SharePoint Server:

• Windows SharePoint Services Administration
• Windows SharePoint Services Timer

To start a service, complete the following steps:

1. Open the Services window.
Start > Administrative Tools > Services

2. Right-click the service and choose Properties. The <Service Name> Properties 
window is displayed.
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3. From the Startup type list, select Automatic. Click OK.

4. If the service does not have a status of Started, right-click the service and choose 
Start.
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Chapter 12: Installation
This chapter contains the procedures you’ll need to follow to run the Workflow 
installation wizard and verify the installation.

The following sections are included:

• Install Workflow
• Verify the installation
• Configure outgoing e-mail settings
• Configure alternate access mappings
• Set up the Workflow system

Install Workflow

Use the following steps to install Workflow on your Web server. As the user 
installing Workflow, you will become the first Workflow administrator.

1. From the Microsoft Dynamics GP Release installation media on your Web 
server computer, double-click the Setup.exe file to open the Microsoft Dynamics 
GP installation window.

2. Click Workflow, and then click Install.

You must install Workflow by running Setup.exe on the installation media.

3. In the License Agreement window, read the terms and conditions. Then, select I 
accept the terms in the License Agreement. Click Next.

4. The SQL Connection Information window appears. 

Enter the name of the server containing your Microsoft Dynamics GP 
databases.

Select the type of authentication that should be used when creating the SQL 
tables and objects used by Workflow. These credentials are used only during the 
installation process.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.
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• If you select SQL Authentication, enter a SQL Server administrator login 
ID and password. Click Next.

5. The Web Service URLs window appears.

Enter the following information.

• The name of the computer you want to install Web Services.

• The port number used in the URL for the Dynamics GP Web service. The 
port number is the port the Web site is using. Typically, the port number is 
48620.

• The port number used in the URL for the Microsoft Dynamics Security 
Admin Service. The port number is the port the Web site is using. Typically, 
the port number is 48621.

Click Next.

6. The Web Site window appears.

Select the IIS Web site you want to use for Workflow. 

• If the IIS Web site you select has not been extended as a SharePoint Server 
Web application, the installation program will extend it for you.
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• If the IIS Web site you select has already been extended as a Web 
application, you can select the managed path you want to use for Workflow. 
For more information about managed paths, see Define a managed path 
(optional) on page 40.

If Business Portal for Microsoft Dynamics GP is installed on this Web server, do not 
select the IIS Web site Business Portal is installed to. Business Portal and Workflow 
can’t use the same Web site.

If you’re installing Workflow on multiple Web servers, you must select the same 
IIS Web site on each server.

Click Next.

7. If the IIS Web site you selected has not been extended as a Web application, the 
Application User Account window appears.

Enter the following information.

Click Next.

8. The Install Program window appears. 

Click Install to install Workflow.

9. The Installation Complete window appears. Click Finish.

Field What to enter

Domain Enter the name of your domain.

Username Enter the name of the domain user account that will act as the 
identity of the Workflow application pool. Typically, this 
account is “User account 2” that you created in User accounts 
for Windows SharePoint Services on page 31, Create user 
accounts for Office SharePoint Server on page 35, Create user 
accounts for SharePoint Server on page 41, or Create user 
accounts for SharePoint Foundation on page 47

Password Enter the password for the domain user account.
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Verify the installation

After the Workflow installation is complete, verify that you can access the Workflow 
Web site. 

1. Open your Web browser.

2. Enter the address of the Workflow Web site. The default address of the 
Workflow Web site is:

http://ServerName:PortNumber/sites/DynamicsGPWorkflow

ServerName is the name of the Web server on which Workflow is installed. 
PortNumber is the port the Web site is using.

If you’ve configured Workflow to use Secure Sockets Layer (SSL), use “https” 
instead of “http” in the URL.

Configure outgoing e-mail settings

You can configure the Workflow system so that users receive e-mail alert messages 
when tasks are assigned to them, or when documents or batches they’ve submitted 
have completed approval processes.

Use the following steps to specify the e-mail address that will be used as the From 
address on the alert messages.

SharePoint Foundation and SharePoint Server:
1. Open SharePoint Central Administration. 

Start > All Programs > Microsoft SharePoint 2010 Products >> SharePoint 
2010 Central Administration

2. Click System Settings.

3. Under the E-Mail and Text Messages (SMS) heading, click Configure 
outgoing e-mail settings. The Web Application Outgoing E-Mail Settings page 
is displayed.

4. In the Outbound SMTP server field, enter the name of your Web server.

5. In the From address and Reply-to address fields, enter valid e-mail addresses.

6. From the Character set list, select the character set appropriate for your 
language. For more information, refer to the SharePoint documentation.

7. Click OK.

Windows SharePoint Services and Office SharePoint 
Server:
1. Open SharePoint Central Administration. 

Start > Administrative Tools > SharePoint 3.0 Central Administration

2. Click the Application Management tab.
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3. Under the SharePoint Web Application Management heading, click Web 
application outgoing e-mail settings. The Web Application Outgoing E-Mail 
Settings page is displayed.

4. If the name of the Workflow Web application does not appear in the Web 
Application field, click the down arrow to change the Web application.

5. In the Outbound SMTP server field, enter the name of your Web server.

6. In the From address and Reply-to address fields, enter valid e-mail addresses.

7. From the Character set list, select the character set appropriate for your 
language. For more information, refer to the SharePoint documentation.

8. Click OK.

Configure alternate access mappings

If you want to install Workflow on additional Web servers, you must configure 
alternate access mappings. Alternate access mappings enable multiple Web 
applications (on multiple Web servers) to be mapped to a single URL.

For example, assume that you installed Workflow on a server named 
WorkflowServer1. Now assume you would like to install Workflow on an 
additional Web server, WorkflowServer 2.

Before you install Workflow on workflowserver 2, you must go to the Alternate 
Access Mappings page in SharePoint Central Administration. You must add an 
internal URL that maps the Workflow Web application on workflowserver2 to the 
URL used by the Workflow Web application on workflowserver1.

To add an internal URL using SharePoint Foundation or SharePoint Server, 
complete the following steps.

This internal URL maps the Workflow Web application on 
workflowserver2 to the URL used by the Workflow Web 
application on workflowserver1.
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1. Open SharePoint Central Administration.
Start > All Programs > Microsoft SharePoint 2010 Products >> SharePoint 
2010 Central Administration

2. Click Application Management.

3. Under the Web Applications heading, click Configure alternate access 
mappings. The Alternate Access Mappings page is displayed.

4. Click Add Internal URLs. The Add Internal URLs page is displayed.

5. If the name of the Workflow Web application does not appear in the Alternate 
Access Mapping Collection field, click the down arrow to change the Web 
application.

6. In the URL protocol, host and port field, enter the URL the Workflow Web 
application should be mapped to.

7. Select a zone. For more information on zones, see the SharePoint 
documentation.

8. Click Save.

To add an internal URL using Windows SharePoint Services or Office SharePoint 
Server, complete the following steps.

1. Open SharePoint Central Administration.
Start > Administrative Tools > SharePoint 3.0 Central Administration

2. Click the Operations tab.

3. Under the Global Configuration heading, click Alternate access mappings. 
The Alternate Access Mappings page is displayed.

4. Click Add Internal URLs. The Add Internal URLs page is displayed.

5. If the name of the Workflow Web application does not appear in the Alternate 
Access Mapping Collection field, click the down arrow to change the Web 
application.

6. In the URL protocol, host and port field, enter the URL the Workflow Web 
application should be mapped to.

7. Select a zone. For more information on zones, see the SharePoint 
documentation.

8. Click Save.

Set up the Workflow system

After you have installed Workflow and verified that you can access the Workflow 
Web site, you can begin setting up the Workflow system. Follow the instructions in 
the Workflow Administrator’s Guide. This manual is available on the Microsoft 
Dynamics GP installation media and Microsoft Dynamics GP documentation Web 
site (http://go.microsoft.com/fwlink/?LinkId=161199).

http://go.microsoft.com/fwlink/?LinkId=161199
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Chapter 13: Maintenance
The following sections explain how to repair Workflow files and remove Workflow 
from your Web server.

• Repair Workflow files
• Remove Workflow

Repair Workflow files

Use the following steps to repair the Workflow files installed on your Web server.

1. In Control Panel, open Add or Remove Programs, Programs and Features

2. Select Microsoft Dynamics GP Workflow. Click Change. 

3. The Modify Installation window appears. Click Repair. 

4. The SQL Connection Information window appears. 

Enter the name of the server containing your Microsoft Dynamics GP 
databases.

Select the type of authentication that should be used when creating the SQL 
tables and objects used by Workflow. These credentials are used only during the 
installation process.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.

• If you select SQL Authentication, enter a SQL Server administrator login 
ID and password. Click Next.

5. The Web Service URLs window appears. Verify the machine name and port 
numbers and then click Next.

6. The Ready to Repair window appears. Click Repair.

7. The Installation Complete window appears. Click Finish.
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Remove Workflow

Use the following steps to remove Workflow from your Web server.

1. In Control Panel, open Add or Remove Programs.

2. Select Microsoft Dynamics GP Workflow. Click Change. 

3. The Modify Installation window appears. Click Remove. 

4. The Ready to Remove window appears. Indicate whether you want to remove 
the Workflow site collection.

• If you’re moving Workflow from one Web server to another Web server, do 
not remove the Workflow site collection.

• If you’ve installed Workflow on multiple Web servers and are removing 
Workflow from one of them, do not remove the Workflow site collection. If 
you do, the Workflow installations on the remaining Web servers will not 
work.

5. Click Remove to remove Workflow.

6. The Remove Complete window appears. Click Finish.
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Part 5: Workflow upgrade
This part of the documentation contains information about upgrading to Workflow 
for Microsoft Dynamics GP 2010. The following chapters are included:

• Chapter 14, “Upgrade checklists,” provides checklists for you to follow when 
you upgrade.

• Chapter 15, “Before you upgrade,” contains information about the steps you 
should take to prepare your system before you upgrade to Workflow for 
Microsoft Dynamics GP 2010.

• Chapter 16, “Upgrade Workflow,” provides instructions for upgrading to 
Workflow for Microsoft Dynamics GP 2010.

• Chapter 17, “After you upgrade,” contains information about the steps you 
should take after you upgrade Workflow for Microsoft Dynamics GP 2010.
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Chapter 14: Upgrade checklists
You can upgrade Workflow from the following

For an overview of the new features in Workflow, refer to the What’s New documentation, 
available in the Documentation folder on the Microsoft Dynamics GP installation media.

This information is divided into the following sections:

• Checklist 1: Workflow for Microsoft Dynamics GP Release 10.0 with Service Pack 4 on 
Office SharePoint Server to Workflow for Microsoft Dynamics GP 2010 on Office 
SharePoint Server

• Checklist 2: Workflow for Microsoft Dynamics GP 2010 on Office SharePoint Server to 
Workflow for Microsoft Dynamics GP 2010 on SharePoint Server 2010

• Checklist 3: Workflow for Microsoft Dynamics GP 2010 on Windows SharePoint 
Services to Workflow for Microsoft Dynamics GP 2010 on Office SharePoint Server

Checklist 1: Workflow for Microsoft Dynamics GP 
Release 10.0 with Service Pack 4 on Office SharePoint 
Server to Workflow for Microsoft Dynamics GP 2010 
on Office SharePoint Server

Use this checklist as your guide to upgrading to Workflow.

Upgrade from Upgrade to

Workflow for Microsoft Dynamics GP 
Release 10.0 with Service Pack 4 on Office 
SharePoint Server

Workflow for Microsoft Dynamics GP 2010 on 
Office SharePoint Server

 Workflow for Microsoft Dynamics GP 2010 
on Office SharePoint Server 

Workflow for Microsoft Dynamics GP 2010 on 
SharePoint Server 2010

Workflow for Microsoft Dynamics GP 2010 
on Windows SharePoint Services 

Workflow for Microsoft Dynamics GP 2010 on 
Office SharePoint Server

Task For more information, see

1. Prepare for the upgrade. Check for new information relating to the 
upgrade since the release of this document.

Microsoft Dynamics GP documentation web site: 
http://go.microsoft.com/fwlink/?LinkId=161199

View the Readme file and make note of the 
items that pertain to your Workflow system.

\\Media\Documentation\GPReadme.chm

Upgrade your hardware and software, if 
necessary.

System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Approve or reject workflow items in 
process.

Documents and batches that are in process during a 
workflow on page 69.

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 70.

2. Upgrade Microsoft 
Dynamics GP.

Upgrade to Microsoft Dynamics GP 2010. Microsoft Dynamics GP Upgrade Guide

3. Upgrade Web Services for 
Microsoft Dynamics GP.

Upgrade to Web Services for Microsoft 
Dynamics GP 2010.

Web Services Installation and Administration Guide

4. Upgrade Workflow. Upgrade to Workflow for Microsoft 
Dynamics GP 2010.

Upgrade Workflow on page 71.

5. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 7, “After you upgrade.”

http://go.microsoft.com/fwlink/?LinkId=161199
http://go.microsoft.com/fwlink/?LinkId=79222
http://go.microsoft.com/fwlink/?LinkID=161197
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Checklist 2: Workflow for Microsoft Dynamics GP 
2010 on Office SharePoint Server to Workflow for 
Microsoft Dynamics GP 2010 on SharePoint Server 
2010

Use this checklist as your guide to upgrading to Workflow.

Checklist 3: Workflow for Microsoft Dynamics GP 
2010 on Windows SharePoint Services to Workflow for 
Microsoft Dynamics GP 2010 on Office SharePoint 
Server

Use this checklist as your guide to upgrading to Workflow.

Task For more information, see

1. Prepare for the upgrade. Upgrade your hardware and software. System requirements on the Web:
http://go.microsoft.com/fwlink/?LinkID=161197

Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 70.

2. Upgrade to SharePoint 
Server 2010, Enterprise 
Edition.

Attach databases to upgrade the content for 
your environment.

Upgrade to SharePoint Server 2010 on page 36.
Checklist for database attach upgrade SharePoint Server 
2010 (http://go.microsoft.com/fwlink/?LinkId=199941)
Attach databases and upgrade to SharePoint Server 2010 
(http://go.microsoft.com/fwlink/?LinkId=199940)

3. Upgrade Web Services for 
Microsoft Dynamics GP.

Upgrade to the 64-bit Web Services for 
Microsoft Dynamics GP 2010.

Web Services Installation and Administration Guide

4. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 17, “After you upgrade.”

Task For more information, see

1. Prepare for the upgrade. Back up your Microsoft Dynamics GP 
databases and perform table maintenance.

Prepare Microsoft Dynamics GP databases for an 
upgrade on page 70.

2. Upgrade Windows 
SharePoint Services.

Install Office SharePoint Server Install Office SharePoint Server on page 36

Run the SharePoint Products and 
Technologies Configuration wizard.

Run the SharePoint Products and Technologies 
Configuration Wizard on page 36

Install the following hotfixes on the Web 
server running Office SharePoint Server.

Install hotfixes on page 38

3. Upgrade Web Services for 
Microsoft Dynamics GP.

Upgrade to the 64-bit Web Services for 
Microsoft Dynamics GP 2010.

Web Services Installation and Administration Guide

4. Perform post-upgrade 
procedures, if necessary.

Learn about additional tasks you may have 
to perform after the upgrade.

Chapter 17, “After you upgrade.”

http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkId=199941
http://go.microsoft.com/fwlink/?LinkId=199940
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Chapter 15: Before you upgrade
This chapter provides information about tasks you must complete before you 
upgrade to Workflow for Microsoft Dynamics GP 2010. This information is divided 
into the following sections:

• System requirement changes
• Documents and batches that are in process during a workflow
• Prepare Microsoft Dynamics GP databases for an upgrade

System requirement changes

The following system requirements have changed since the previous release of 
Workflow. For complete system requirements, refer to http://go.microsoft.com/
fwlink/?LinkID=161197.

• This release of Workflow is compatible only with Microsoft Dynamics GP 2010. 
You must upgrade to Microsoft Dynamics GP 2010 before you can upgrade 
Workflow. 

• Microsoft Windows 7 Professional Edition and Ultimate Edition are additional 
supported client operating systems.

• Internet Explorer 8.0 is supported, but not required.

Documents and batches that are in process during a 
workflow

Documents and batches that are in process during a workflow cannot be upgraded 
to Workflow for Microsoft Dynamics GP 2010. A document or batch must be either 
approved or rejected before you can upgrade. This includes documents and batches 
that are in the workflow process for integrating products. If the approval process 
cannot be completed for a document or batch, you must reject it. After you upgrade 
to Workflow for Microsoft Dynamics GP 2010, you can modify the document or 
batch that you have rejected and then resubmit it.

To successfully upgrade Workflow, you must complete the following tasks:

• Ask your users to stop submitting new documents and batches.

• Print the Active Tasks report to display a list of active tasks and the approvers 
they are assigned to.

• Approve or reject document or batch that are in process. You will have to 
resubmit documents and batches that have a status of Pending Changes. This 
includes documents and batches that are in the workflow process for 
integrating products.

Documents and batches that are in process have the following statuses.

Submitted

Pending Approval

Pending Changes 

http://go.microsoft.com/fwlink/?LinkID=161197
http://go.microsoft.com/fwlink/?LinkID=161197
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Prepare Microsoft Dynamics GP databases for an 
upgrade

Before you upgrade Workflow, we recommend making a backup of your Microsoft 
SQL Server databases and performing table maintenance procedures.

If you performed table maintenance procedures before you upgraded Microsoft 
Dynamics GP, you don’t need to do so again before upgrading Workflow. However, 
we recommend that you make another backup of your Microsoft Dynamics GP 
databases before you upgrade Workflow.

Back up Microsoft Dynamics GP and SharePoint data
You should make at least one complete backup of your Microsoft Dynamics GP 
databases before upgrading. It’s a good idea to make a backup before completing 
table maintenance procedures, in case you encounter any problems in that process.

You should back up SharePoint content and configuration databases at the same 
time as you back up your Microsoft Dynamics GP databases. 

For more information about backing up databases in SQL Server, refer to SQL 
Server Books Online.

Table maintenance
For your SQL database, you should run the following database maintenance routine 
against the DYNAMICS database and all company databases in Microsoft SQL 
Server Management Studio. The database maintenance routine will help to ensure 
that your table structure is ready to be upgraded if there are no errors indicated.

DBCC CHECKDB (Database Name)

If you prefer to perform table maintenance only on the tables that have changed, 
lists of tables that have changed from previous releases are available on the 
Microsoft Dynamics GP Release media as part of the Software Developers’ Kit 
(SDK).

It’s a good idea to make a second backup after performing table maintenance, but before 
upgrading to Microsoft Dynamics GP Release. That way, if you encounter unexpected 
problems while upgrading, you won’t have to repeat the table maintenance step.
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Chapter 16: Upgrade Workflow 
This chapter contains the procedures to upgrade to Workflow for Microsoft 
Dynamics GP 2010 in the order they must be performed. Before you upgrade 
Workflow, be sure to review the information in Chapter 15, “Before you upgrade.”

This information is divided into the following sections:

• Upgrade Workflow prerequisites
• Upgrade Workflow

Upgrade Workflow prerequisites

You need to upgrade the following prerequisites.

Microsoft Dynamics GP You must upgrade Microsoft Dynamics GP to 
Microsoft Dynamics GP 2010 before upgrading Workflow. Microsoft Dynamics GP 
can be installed from the Microsoft Dynamics GP installation media. 

For more information, refer to the Microsoft Dynamics GP Upgrade Guide located 
at the Microsoft Dynamics GP documentation resources web site (http://
go.microsoft.com/fwlink/?LinkId=161199)

Web Services for Microsoft Dynamics GP You must upgrade Web Services 
for Microsoft Dynamics GP to Web Services for Microsoft Dynamics GP 2010 before 
upgrading Workflow. Web Services for Microsoft Dynamics GP 2010 can be 
installed from the Microsoft Dynamics GP 2010 installation media. 

For more information, refer to the Microsoft Dynamics GP Web Services Installation 
and Administration Guide located at the Microsoft Dynamics GP documentation 
resources web site (http://go.microsoft.com/fwlink/?LinkId=161199).

Upgrade Workflow

Use the following steps to upgrade Workflow. 

1. From the Microsoft Dynamics GP Release installation media on your Web 
server computer, double-click the Setup.exe file to open the Microsoft Dynamics 
GP installation window.

2. Click Workflow, and then click Install.

You must run the Setup.exe on the installation media.

3. In the License Agreement window, read the terms and conditions. Then, select I 
accept the terms in the License Agreement. Click Next.

http://go.microsoft.com/fwlink/?LinkId=161199 
http://go.microsoft.com/fwlink/?LinkId=161199 
http://go.microsoft.com/fwlink/?LinkId=161199
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4. The SQL Connection Information window appears. 

Enter the name of the server containing your Microsoft Dynamics GP 
databases.

Select the type of authentication that should be used when creating the SQL 
tables and objects used by Workflow. These credentials are used only during the 
installation process.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.

• If you select SQL Authentication, enter a SQL Server administrator login 
ID and password. Click Next.

5. The Web Service URLs window appears.

Enter the following information.

• The name of the computer where Web Services is installed.

• The port number used in the URL for the Dynamics GP Web service. 
Typically, the port number is 48620. You can use the DynamicsGP.config file 
to view the port number of the Dynamics GP Web service. This file is 
typically found in this location:

C:\Program Files\Microsoft Dynamics\GPWebServices\ServiceConfigs\
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• The port number used in the URL for the Dynamics Security Admin 
Service. Typically, the port number is 48621. You can use the 
DynamicsSecurityAdmin.config file to view the port number of the 
Dynamics Security Admin Service. This file is typically found at this 
location:

C:\Program Files\Microsoft Dynamics\GPWebServices\ServiceConfigs\

Click Next.

6. The Upgrade window appears. 

Click Upgrade to upgrade Workflow.

7. The Upgrade Complete window appears. Click Finish.
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Chapter 17: After you upgrade
We recommend that you complete the steps in this chapter after you upgrade 
Workflow.

This chapter contains the following sections:

• Verify the upgrade
• Resubmit documents and batches

Verify the upgrade

After the Workflow upgrade is complete, verify that you can access the Workflow 
Web site. 

1. Open your Web browser.

2. Enter the address of the Workflow Web site. The default address of the 
Workflow Web site is:

http://ServerName:PortNumber/sites/DynamicsGPWorkflow

ServerName is the name of the Web server on which Workflow is installed. 
PortNumber is the port the Web site is using.

If you’ve configured Workflow to use Secure Sockets Layer (SSL), use “https” 
instead of “http” in the URL.

Resubmit documents and batches

Before upgrading to Workflow for Microsoft Dynamics GP 2010, you approved or 
rejected documents and batches that were in process during a workflow, including 
documents and batches that were in the workflow process for integrating products. 
After the upgrade, you can modify the documents or batches that you have rejected 
and then resubmit them. 

For more information about modifying and resubmitting documents and batches, 
refer to the Workflow Administrator's Guide and the documentation for a specific 
module (http://go.microsoft.com/fwlink/?LinkId=161199).

http://go.microsoft.com/fwlink/?LinkId=161199
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T
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U
uninstalling Workflow 50
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upgrading

approving workflow items 55
checklist 53
resubmitting workflow items 61
SQL preparation 55
verifying the upgrade 61
Workflow 48

URLs
adding internal URLs 47
Workflow web site URL 45

user accounts
for Office SharePoint Server 33
for Windows SharePoint Services 29

W
web applications

creating in Windows SharePoint 
Services 31

for Workflow 36
Web Server (IIS), roles for Windows 

Server 2008 25
web service extensions, enabling for 

ASP.NET 2.0 26
web services, installing 26
Web Services for Microsoft Dynamics GP

installing 26
upgrading 57

web sites, Workflow web site 9
Windows Server 2003, installing 25
Windows Server 2008

installing 25
roles for IIS 25

Windows SharePoint Services
configuring a Service Principal Name 

32
creating a web application 31
creating user accounts for 29
installing 29
running the configuration wizard 30

Windows Trusted Authentication, 
described 19

Windows Workflow Foundation, 
installing updates for 36

Workflow
from a previous release 53
how users interact with the system 8
installation checklist 10
installing 43, 57
overview 7
removing 50
repairing 49
setting up 48

Workflow Administrator’s Guide, 
accessing 48

workflow items, approving before 
upgrade 55

Workflow web site, described 9
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